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Operating Instructions
Printer Reference 1

For safety, please read this manual carefully before you use this product and keep it
handy for future reference.



Introduction

This manual contains detailed instructions on the operation and maintenance of this machine. To get
maximum versatility from this machine all operators should carefully read and follow the instructions in
this manual. Please keep this manual in a handy place near the machine.

Please read the Safety Information in the Operating Instructions before using this machine. It contains
important information related to USER SAFETY and PREVENTING EQUIPMENT PROBLEMS.

Important

Parts of this manual are subject to change without prior notice. In no event will the company be liable
for direct, indirect, special, incidental, or consequential damages as a result of handling or operating
the machine.

Warning:

Use of controls or adjustment or performance of procedures other than those specified in this manual
might result in hazardous radiation exposure.

Trademarks
Microsoft®, Windows® and Windows NT® are registered trademarks of Microsoft Corporation in the
United States and/or other countries.

Adobe®, PostScript®, Acrobat® and PageMaker® are registered trademarks of Adobe Systems Incor-
porated.

PCL® is a registered trademark of Hewlett-Packard Company.

AppleTalk, Apple, Macintosh, Mac and TrueType are registered trademarks of Apple Computer, Incor-
porated.

Ethernet® is a registered trademark of Xerox Corporation.

Other product names used herein are for identification purposes only and might be trademarks of their
respective companies. We disclaim any and all rights in those marks.

Notes:

Some illustrations in this manual might be slightly different from the machine.
Certain options might not be available in some countries. For details, please contact your local dealer.

Note:

The proper names of the Windows operating systems are as follows:

» The product name of Windows® 95 is Microsoft® Windows® 95.

* The product name of Windows® 98 is Microsoft® Windows® 98.

e The product name of Windows® Me is Microsoft® Windows® Millennium Edition (Windows Me).

» The product names of Windows® 2000 are as follows:
Microsoft® Windows® 2000 Advanced Server
Microsoft® Windows® 2000 Server
Microsoft® Windows® 2000 Professional

» The product names of Windows® XP are as follows:
Microsoft® Windows® XP Professional
Microsoft® Windows® XP Home Edition

* The product names of Windows NT® 4.0 are as follows:
Microsoft® Windows NT® Server 4.0
Microsoft® Windows NT® Workstation 4.0



How to Read This Manual

Symbols

In this manual, the following symbols are used:

/\ WARNING:
This symbol indicates a potentially hazardous situation which, if instructions
are not followed, could result in death or serious injury.

N\ CAUTION:

This symbol indicates a potentially hazardous situation which, if instructions
are not followed, may result in minor or moderate injury or damage to property.

* The statements above are notes for your safety.

ﬂlmportant
If this instruction is not followed, paper might be misfed, originals might be

damaged, or data might be lost. Be sure to read this.

5] Preparation

This symbol indicates the prior knowledge or preparations required before op-
erating.

@ Note

This symbol indicates precautions for operation, or actions to take after misop-
eration.

? Limitation

This symbol indicates numerical limits, functions that cannot be used together,
or conditions in which a particular function cannot be used.

A Reference
This symbol indicates a reference.

[ ]

Keys that appear on the machine's display panel.

Keys and buttons that appear on the computer's display.
[ ]

Keys built into the machine's control panel.
Keys on the computer's keyboard.
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Manuails for This Machine

The following manuals describe the operational procedures and maintenance of
this machine.

To enhance safe and efficient operation of this machine, all users should read
and follow the instructions carefully.

%
%

Printer Reference 1

Describes the system settings, procedures and functions for using this ma-
chine. This manual is also included as a PDF file on the CD-ROM labeled
“Printer Drivers and Utilities”.

Printer Reference 2

Describes the procedures and provides necessary information about using
this machine. This manual is included as a PDF file on the CD-ROM labeled
“Printer Drivers and Utilities”.

Network Printing Guide Operating Instructions
Describes the procedures and provides necessary information about setting
up and using the printer under the network environment. We recommend

this manual as your first choice to read, and it is included as a PDF file on the
CD-ROM labeled “Printer Drivers and Utilities”.



Getting Started

Printer Drivers for This Machine

Printing requires installation of a printer driver for your operating system. The
following drivers are included on the CD-ROM labeled “Printer Drivers and
Utilities” that comes with the machine.

Printer Language PostScript 3 PCL 5e

Operating system

Windows 95 ™ NED J
Windows 98 "2 NET N
Windows Me ™ \ *10 J
Windows 2000 ™ NET N
Windows XP NER N
Windows NT 4.0 NERD N
Mac OS 7 NEG

Mac OS X "8 NEE:

*1
*2
*3
*4

*5

*6

*7

*8

*9

*10

*11

*12

L)

Microsoft Windows 95 operating system

Microsoft Windows 98 operating system

Microsoft Windows Millennium Edition

Microsoft Windows 2000 Professional

Microsoft Windows 2000 Server

Microsoft Windows XP Professional

Microsoft Windows XP Home Edition

Microsoft Windows NT Server operating system version 4.0, Microsoft Windows NT
Workstation operating system version 4.0 in a computer using x86 processors.
Versions 7.6.1 or later of Mac OS can be used.

Required version is 10.1 or later.

Requires Service Pack 4 or later.

The Adobe PostScript 3 printer drivers and PostScript 3 Printer Description (PPD)
files are included on the CD-ROM labeled “Printer Drivers and Utilities”.

The PostScript 3 Printer Description (PPD) files are included on the CD-ROM labeled
“Printer Drivers and Utilities”.

The PostScript Description (PPD) files are included on the CR-ROM labeled “Printer
Drivers and Utilities”.

Adobe PostScript 3 Printer Drivers and PPDfiles

The Adobe PostScript 3 printer drivers and the PPD files are included on the
CD-ROM that comes with the machine. Adobe PostScript 3 printer driver al-
lows the computer to communicate with the printer via a printer language.
The PPD files allow the printer driver to enable the printer specific functions.
= p.19 “Windows 95/98/Me - Installing the PostScript 3 Printer Driver”

= p.21 “Windows 2000/ Windows XP- Installing the PostScript 3 Printer
Driver”

= p.24 “Windows NT 4.0 - Installing the PostScript 3 Printer Driver”

= p.27 “Mac OS - Installing the PostScript 3 Printer Driver”

= p.29 “Mac OS X- Installing the PostScript 3 Printer Driver”



Printer Drivers for This Machine

 PCL 5e Printer Drivers
The PCL 5e printer driver is the mini-driver that belongs to the operating sys-
tem. Installing the file that is included on the CD-ROM sets the mini-driver as
the printer driver of this machine. Printer drivers allow the computer to com-
municate with the printer via a printer language.
= p.31 “Windows 95/98/Me - Installing the PCL 5e Printer Driver”
= p.32 “Windows 2000/ Windows XP- Installing the PCL 5e Printer Driver”
= p.35 “Windows NT 4.0 - Installing the PCL 5e Printer Driver”

? Limitation
O The PCL 5e printer driver cannot be used in the machine that has a resolution
of 400 dpi.




Getting Started

Software and Utilities Included on the CD-
ROM

There is a CD-ROM that comes with the machine. The CD-ROM is labeled
“Printer Drivers and Ultilities”. The following items are included on the CD-
ROM.

+ SmartNetMonitor for Admin
This utility is for the system administrator to manage printers on the network.

/O Reference

See SmartNetMonitor for Admin online Help for more information about
using the SmartNetMonitor for Admin.

+» SmartNetMonitor for Client
This utility is for users to manage their own print status on the network.

p Reference

See SmartNetMonitor for Client online Help for more information about
using the SmartNetMonitor for Client.

< Acrobat Reader
This utility allows you to read PDF (Portable Document Format).

& Note

O Documentation about using the machine is included on the CD-ROM in
PDF. See Acrobat Reader online Help for more information about using
Acrobat Reader.

ﬂlmportant

O If you upgrade to Windows 2000 from Windows 95/98/Me or Windows NT
4.0, the software and utilities must be uninstalled prior to installing Windows
2000. Reinstall them in the Windows 2000 environment.



Guide to This Machine

Guide to This Machine

Control Panel

&Y

»
h

i
13 12

1. [User Tools ] key

Press to change the default settings to
meet your requirements.

2. [On Line] key
Allows data on a computer to be printed
on this machine (online status).

& Note

O When the Auto On Line indicator is
lit, the machine will automatically en-
ter the online status when receiving
data from a computer without having
to press the [On Line] key.

3. [Auto On Line] key

You can select whether the machine auto-
matically switches to On Line mode
when it receives data from a computer.

When pressing this key to turn on Auto
On Line, the indicator will light. Then,
when data from a computer is received,
the machine will automatically enter the
On Line status (In this case, it is not nec-
essary to press the [On Line] key).

ZGAHOT1E

4. Display Panel

Shows operation status, error messages,
and function menus.

5. [Proof] key

Press to make proof prints.
6. [Print] key
Press to start printing.

7. [Start] key

Press to start master making.

8. [Clear/Stop] key

Press to delete a number entered or to
stop printing.

9. Number keys

Press to enter the desired number of
prints and data for selected modes.

10. (Q)(>](2)(V] keys
Use to highlight items you wish to select
on the display panel.

11. Function keys

These keys correspond to the selectable
items on the display panel.




Getting Started

12. Data In indicator (Green) 13. Error indicator (Red)
Indicates the status of this machine: Indicates the status of this machine:
* On: Data waiting for Master Making * On: An error has occurred. Master
and printing is in the machine. Making and printing stops.
¢ Blinking: Data is being received, or * Off: Normal status
Master Making or printing is in
progress.
e Off: Master Making and printing are
completed.
Display Panel

The display panel shows the status of the machine, error messages and function
menus.

ﬁ*lmportant
O Do not apply a strong shock or force of about 30 N (about 3 kgf) or more to
the display panel. Otherwise, the display can get damaged.

Displays and key operations

The display panel shows the machine status, error messages, and function men-
us.

[OReady for Master Makine/ Printing 3
[Eldd 0. O
1 Letter 1003 Std. 0. 0w | -4
[Origiral][ Ratio |[Per.Tvee|[Inege =i
2| [
1. Items for the selected function. 3. Machine status or messages.
2. These keys correspond to the se- 4. Items which can be selected.

lectable items shown above them on
the display panel. To select an item
shown on the display panel, press
the key directly below it.



Guide to This Machine

< Common key explanations

[OK] Confirms a function selection or an entered value.

[Cancel] Cancels a function selection or an entered value and returns
to the previous display.

[Prev.][Next] When there are too many items to fit on the display panel, use
these keys to move between pages.
[AX> XA V]II-=] Press to highlight items you wish to select on the display pan-
el.
[Select] Selects a value.
[Exit] Returns to the previous display.
& Note
O When you select an item on the display panel, it is highlighted (e.g. ENRY).
Items shown dimmed (e.g. ) cannot be selected.
Offline/Online

The screens displayed are different in the online status and offline status.

& Note
O When the machine is offline, it cannot receive data from a computer.

O When the machine is online, it can receive data from a computer.

Offline Online

[ JReady for Master Makinz/ PFrinting [ IReady <0nline
=847 0. Omm =4 0. O
Letter 1003 2td. 0. Oram Auto Std. (1. Oram
[Orizinal || Ratio |[Per.Tyvpe||Imaze <% [Pnt.5ize|[Ppr.Tvpe || Inage <]

[
1 EGGO001

1. [PntSize] A Reference

The paper size in the Paper Feed Tray can

For information about the other
be selected.

setting items on the display panel,
& Note see Operating Instructions.

O When “Auto” is selected, the paper
size in the Paper Feed Tray will be au-
tomatically detected.

O A message “Paper size mismatch...”
appears on the display panel when the
paper size in the Paper Feed Tray is
different from the paper size of data
set on the computer. Set paper of the
correct size.



Getting Started

Network Settings

You can make the necessary network settings using the control panel of this ma-
chine.

It is also possible to use “SmartNetMonitor for Admin” when making settings
for IP Addresses in environments you can use TCP/IP.

Setting on the Control Panel

Make the settings for necessary items for the network environment you are go-
ing to use.

The followings are the items that can be set as well as the factory settings.

Item Factory settings
IP Address 011.022.033.044
Network boot NONE

ﬂ Press the [User Tools] key.

o ody od op
°c0

CO 3oy —

o[ o> o oop

C ) C | C)

ZDZS110E

The User Tools screen appears.

g Press [Next].
B Select [7 Set O/L Paramet's] using the [<], [>], [A]) or [V] keys.
ﬂ Press [OK].
Uzer Tools 2/2 Select with <
b Stamp B fdmin. Mode

7 Set O/L Paramet’s

[ Prev. || Mext |[ Cancel |[ 0K |

The Online Parameter Settings items appear.



Network Settings

B Press [Next].

Bet 0/L Paramet’s

1 Set aut-0/L def

1/3 Select with o3

i 2 Print Size Def.

3 List/Test Print 4 Print PS Errors
[ Prev. || Mext |[ Cancel |[ 0K |
B Set the IP Address.

@ Check to make sure that [5 IP Address] is selected.

et 0/L Paramet’s 2/3 Select with <%
B Ethernet Speed

7 Network 8 1/0 Timeout
[ Prev. || Mext |[ Cancel |[ 0K |
@ Press [OK].

The IP Address setting screen appears.
© Enter the IP Address using the number keys.
* You can change the numbers that are highlighted.
e The cursor can be moved using the [ <] key or the [ >] key.
* The numbers are entered 3 digits at a time.

[P Address Uze——to move
[EE.165. 0. &0
[ Cancel || 0K ]
O Press [OK].
After finishing the IP Address settings, the screen returns to the screen on
step B.

ﬂ If necessary, make the Network boot settings.
@ Select [7 Network] using the [<], [>], [2]) or [V] keys.
@ Press [OK].
The network boot settings screen appears.
© Select the Network boot to be set using the [<], [>], [2] or [V] keys.

Metwaorlk Select with oy
Mone R&RP + TFTP
BOOTP R&RP & BOOTP
[ Prev. || Mext |[ Cancel |[ 0K |
Valid method ™
Item
AP RA BO DH
ARP+PING @)
ARP&RARP @) O
ARP&BOOTP @) O
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Valid method ™
Item
AP RA BO DH
ARP&RARP&BOOTP O O @)
m None (Factory Settings)
RARP+TFTP O
BOOTP O
RARP&BOOTP O O
DHCP O
‘1 The valid methods are in order from the left: ARP+PING, RARP+TFTP,
BOOTP, DHCP.
& Note
O It is necessary to set the server when using RARP+TFTP, BOOTP, and
DHCP.
O When setting the IP Address on the control panel, use None.
A Reference
See the Network Printing Guide when using DHCP.
O Press [OK].

This completes the Network boot settings.
B Press the [User Tools] key.

L[ ] n
o odh Og op
(o]
— o0 —
o[ o o oop
( ) | ( ) | ( ) ||l C )

ZDZS110E

A message “Parameter settings have been changed. You must restart the ma-
chine before the new settings take effect.” appears on the display panel.

g Restart the machine.
The set items become valid.

10



Network Settings

Other Settings

The followings are other items you can set using the control panel besides the IP
Address and the Network boot.

& Note
O The settings are performed in Web Status Monitor or SmartNetMonitor for
Admin. See the corresponding online Help for details.

Items Factory Settings
Subnet mask 000.000.000.000
Default gateway address 000.000.000.000
Access control address 000.000.000.000
Access control mask 000.000.000.000
Frame Type (Netware) Automatic selection
Valid protocol All valid
iQ'f‘Aboui addresses

% Subnet Mask
Mask value for using one part of an IP Address as a network address.

< Default Gateway Address
Host or router address used as a gateway when negotiating with (printing, in-
formation gathering) a workstation on a different network.

& Note
O Check with your network administrator for the address to be set.

O If you do not know the address to be set, use the factory settings.

11
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Getting Started

LFAbout Access Control

The access control address and the access control mask are used to limit a print-
able workstation, by using an IP Address. If it is not necessary to limit printing,
set “0.0.0.0”.

& Note

O If the access control address mask and the mask of the address of the work-
station trying to print is the same, then access will be granted.

O For example, if the access control address is set to 192.168.15.16, depending
on the mask value, the address of the accessible workstation is as follows:

(XXX can be any value).

Access control mask Accessible Addresses
0. 0. 0.0 XXX XXX XXX
255. 0. 0.0 192 XXX XXX XXX
255.255. 0. 0 192.168. XXX. XXX
255.255.255. 0 192.168. 15.XXX
255.255.255.255 192.168. 15. 16




Connecting the Machine

Connecting the Machine

ZGAH140E

1. Ethernet Interface 2. Parallel Interface
Connector for the 100BASE-TX or Connector for the parallel interface cable
10BASE-T cable used when connecting to used when connecting to a computer.

the network.

Requirements

Requirements

Before using this machine, make sure that all the environmental and electrical
requirements have been met. Connect the machine to the host computer using
the parallel port, Network Interface Board, or both.

Make sure that all the cables, connectors, and electrical outlets necessary to at-
tach the machine to the host computer or network are present.

ﬂlmportant
O The interface cable is not supplied. It is your responsibility to provide the in-
terface cable appropriate for the computer that you are using.

A Reference
For Ethernet Board connection, see p.14 “Connecting the Network Cable to
the Machine”.

For more information about using the parallel port, see p.15 “Connecting the
Machine to the Host Using the Parallel Cable”.

13
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Getting Started

Interface cable requirements

As the cables may differ depending on the type of computer, make sure you
check your computer and prepare the appropriate cable.

@ Note

O Use a shielded cable for the interface cable. Using another cable, instead of
shielded cables, may cause radio interference.

Parallel cable requirements

Connect the machine to the host computer using a parallel port. This machine
does not provide the parallel cable to connect the machine to the host computer.

The machine's parallel interface is a standard bidirectional interface. It requires
a standard 36-pin parallel cable compliant with IEEE 1284 and a parallel port
available on the host computer.

& Note
O Do not use a parallel cable that is longer than 3 meters (10 feet).

Connecting the Network Cable to the Machine

iﬁklmportant

O Before connecting an interface cable between the machine and a computer,
make sure that the machine is not operating, and then turn off the main power
switches of the machine and the computer.

O Be sure to use the designated interface cable. Using another cable may cause
radio interference.

After setting up this machine to support the network environment, connect the

Ethernet interface cable. Connect a 10BASE-T or 100BASE-TX cable to the Ether-

net board.

ﬂ Connect the Ethernet interface cable into the Ethernet interface at the right
side of the back of the machine.

-

ZGAH160E




Connecting the Machine

ﬂ Turn on the main power switch.

< Using the switches and understanding the LEDs

L)
Is on while the Ethernet board is O
working properly.
Is on while the 100BASE-TX is
working, and off when the —®
10BASE-T is working. ©
Is on while the machine is
properly connected to the
network.

ZGAH130E

Connecting the Machine to the Host Using the Parallel Cable

Connect the machine to the host computer using a parallel cable compliant with
IEEE 1284 (available separately).

Follow these steps to connect the machine to the host computer.

ﬂlmportant
O Before connecting an interface cable between the machine and a computer,

make sure that the machine is not operating, and then turn off the main power
switches of the machine and the computer.

O Be sure to use the designated interface cable. Using another cable may cause
radio interference.

ﬂ Plug the 36-pin end of the parallel cable into the parallel port at the right
side on the back of the machine.

g Squeeze the wire clips on each side of the connector together until they
snap into place. The clips hold the cable securely in place.

>\
\

=

/ ZGAH150E

B Plug the other end of the parallel cable into the computer's parallel port.

15
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e
2. Installing the Printer Driver

and Software

Installing the Printer Driver and Software

This manual assumes that you are familiar with general Windows procedures
and practices. If you are not, see the documentation that comes with Windows
for details.

& Note

O In this manual, "CD-ROM" refers to the “Printer Drivers and Utilities” CD-
ROM that comes with the machine unless specified otherwise.

/O Reference

For more information about the printer drivers, see p.2 “Printer Drivers for
This Machine”.

For more information about the software and utilities, see p.4 “Software and
Utilities Included on the CD-ROM”.

ﬂlmportant
O Before starting the installation, close all documents and applications. In a net-

work environment, make sure that users who are logged on are disconnected.

O After installing a printer driver, you must restart the computer.

& Note

O If “plug and play” is started, click [Cancel] in the [New Hardware Found], [Device
Driver Wizard] or [Found New Hardware Wizard] dialog box, and then insert the
CD-ROM. The [New Hardware Found], [Device Driver Wizard] or [Found New Hard-
ware Wizard] dialog box appears depending on the system version of the Win-
dows 95/98/Me or Windows 2000/ Windows XP.

O Use the appropriate language on the CD-ROM folder: ENGLISH(English),
DEUTSCH (German), FRANCAIS (French), ITALIANO(Italian), ESPANOL
(Spanish), NEDRLNDS (Dutch).

O The languages displayed in the WSMHLP folder (Web Status Monitor Help)
in the Help folder on the CD-ROM are as follows: DE (German), EN (English),
ES (Spanish), FR (French), IT (Italian), NL (Dutch).

17
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Installing the Printer Driver and Software

iQ'f‘Using the Shared Printer on Windows 2000/Windows XP or Windows
NT 4.0 for Windows 95/98/Me Client or Windows NT 4.0 Client

% Windows 2000/Windows XP
If you want to share the machine on Windows 2000/ Windows XP, install the
printer driver of Windows 95/98/Me or Windows NT 4.0 as an alternate
driver.

% Windows NT 4.0

If you want to share the machine on Windows NT 4.0, install the printer driv-
er of Windows 95/98/Me as an alternate driver.

@ Note

O When using the “alternate driver” function with the Windows NT 4.0, use the
Windows NT 4.0 Service Pack 4 or later.

For more information about installing the printer driver as an alternate driver,
see p.21 “Windows 2000/ Windows XP- Installing the PostScript 3 Printer Driv-
er”, p.24 “Windows NT 4.0 - Installing the PostScript 3 Printer Driver”, p.32
“Windows 2000/ Windows XP- Installing the PCL 5e Printer Driver”, p.35 “Win-
dows NT 4.0 - Installing the PCL 5e Printer Driver”.



Installing the PostScript 3 Printer Driver

Installing the PostScript 3 Printer Driver

This section describes basic instructions for installing the PostScript 3 printer
driver. The actual procedure may vary depending on the operating system. Fol-
low the appropriate procedure below.

ﬂlmportant

O When updating the printer driver by installing the latest version, you should
uninstall the former version . See “Uninstalling the Printer Driver and Software”
in the Printer Reference 2.

Windows 95/98/Me - Installing the PostScript 3 Printer Driver

Installing the printer driver

It is necessary to install a printer driver and a PPD file to print from Windows
95/98/Me.

Follow these steps to install a printer driver and a PPD file.
ﬂ Close all applications that are currently running.

g Click [Start] on the taskbar, point to [Settings], and then click [Printers].
The [Printers] window appears.

E) Double-click the [Add Printer] icon.
[Add Printer Wizard] starts.

B Click Next].

B Check [Local printer] and click [Next].
A dialog box for selecting the manufacturer and model name appears.

[ ciick [Have Disk].
A dialog box for installing the printer driver from a disk appears.

ﬂ Insert the CD-ROM into the CD-ROM drive.
B Click [Browse].
g Use the [Drives] list box to select the CD-ROM drive.

ﬂﬂ In the [Folders] box, double-click [DRIVERS], [PS], [WIN9X_ME]. Then double-
click the folder of the appropriate language for the operating system.

@ click [0k,

B cick [0K.
A dialog box for selecting the machine model appears. 19
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Installing the Printer Driver and Software

[B Click to select the name of the machine whose driver you want to install,
and then click [Next].

m In the [Available ports] box, click to select [Printer Port], and then click [Next].
A dialog box for changing the machine name appears.

[B Change the name of the machine if you want, and then click [Next].

[E In the next dialog box, you will be asked to print a test page. Select [No], and
then click [Finish].
The installer copies the printer driver and a PPD file from the CD-ROM to the
computer's hard disk.

& Note
O Print a test page after completing installation and restarting Windows.

m Restart Windows.

Setting up options

ﬂlmportant
O If the machine is equipped with certain options (Sorter or Memory Unit), you

should set up the options with the printer driver.

& Note

O When setting up options, you should access the [Printer Properties] dialog box
from Windows. You cannot set up options by accessing the [Printer Properties]
dialog box from an application.

ﬂ Click [Start] on the taskbar, point to [Settings], and then click [Printers].
The [Printers] window appears.

ﬂ Click to select the icon of the machine you want to use.

E) On the [File] menu, click [Properties].
The [Printer Properties] dialog box appears.

ﬂ Click the [Device Options] tab.

B In the [Installable options] group, select the option you have installed on the
machine.

Use the [Change Setting for] list to select the appropriate setting for the selected
option.

E Click [Apply] to apply the settings you made.
ﬂ Repeat steps | - [ for all options.
8 After making settings for all options, click [OK].



Installing the PostScript 3 Printer Driver

Windows 2000/Windows XP- Installing the PostScript 3 Printer
Driver

Installing the printer driver

It is necessary to install a PPD file to print from Windows 2000/ Windows XP.
Follow these steps to install a PPD file.

? Limitation

O Installing a printer driver requires Manage Printers permission. Members of
the Administrators and Power Users groups have Manage Printers permis-
sion by default. When you install a printer driver, log on using an account
that has Manage Printers permission.

@ Note

O If you want to share the machine on Windows 2000/ Windows XP, use the
[Sharing] tab in the Printer Properties to specify the alternate printer driver.
For details, see the operating instructions for Windows 2000/ Windows XP.

O When prompted for the alternate printer driver location, select the following
folder on the CD-ROM:

e Windows 95/98/ME:\ DRIVERS \ PS \ WIN9X_MEN\ (Language)
¢ Windows 2000, Windows XP:\ DRIVERS\PS\WIN2000\ (Language)
e Windows NT4.0:\DRIVERS \ PS \ NT4 \ (Language)

ﬂ Close all applications that are currently running.

ﬂ Click [Start] on the taskbar, point to [Settings], and then click [Printers].
The [Printers] window appears.

@ Note

O With Windows XP Professional, access the [Printers and Faxes] window
from [Start] on the taskbar.

O With Windows XP Home Edition, access the [Printers and Faxes] window by
clicking [Start] on the taskbar. Then click [Control Panel], [Printers and Other
Hardware] and then [Printers and Faxes].

B Double-click the [Add Printer] icon.

[Add Printer Wizard] starts.

& Note
O With Windows XP, Click [Add a printer].

O ciick [Nexi].

B After making sure that the [Local printer] option has been selected, click
[Next].

A dialog box for selecting the machine port appears. 21
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B Select the port you want to use, and then click [Next].
A dialog box for selecting the manufacturer and model name appears.

ﬂ Click [Have Disk].
A dialog box for installing the driver from a disk appears.

B Insert the CD-ROM into the CD-ROM drive.

g Change the drive name in the list box to the name of the CD-ROM drive,
and then click [Browse].

[m Double-click [DRIVERS], and [PS], [WIN2000]. Then double-click the folder of
the appropriate language for the operating system.

@ ciick [open].
B cick [oK.

A dialog box for selecting the machine model appears.

[B Click to select the name of the machine whose driver you want to install,
and then click [Next].
A dialog box for changing the machine name appears.

[ﬂ Change the name of the machine if you want, and then click [Next].

[B If you want to share this machine over the network, select [Share as]. If not,
select [Do not share this printer]. Press [Next] to continue.

& Note

O When selecting [Share as], if necessary enter the location of the machine
and a comment about the machine.

[@ In the next dialog box, you will be asked to print a test page. Select [No], and
then click [Next].
A confirmation dialog box appears.

& Note
O Print a test page after completing installation and restarting Windows.

m Make sure that the settings you have set are correct, and then click [Finish].
The installer copies the PPD files from the CD-ROM to the computer's hard disk.

& Note

O If the [Digital Signature Not Found] dialog box appears, click [Yes] to continue
the installation.

O During installation in Windows XP, the [Hardware Installation] dialog box
may appear. In this case, click [Continue Anyway] to continue the installation.

m Restart Windows.
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Setting up options

? Limitation

O Changing the settings of the machine requires Manage Printers permission.
Members of the Administrators and Power Users groups have Manage Print-
ers permission by default. When you set up options, log on using an account
that has Manage Printers permission. For details about access authority, see
Help for Windows.

ﬂlmportant
O If the machine is equipped with certain options (Sorter or Memory Unit), you
should set up the options with the printer driver.

& Note

O When setting up options, you should access the [Printer Properties] dialog box
from Windows. You cannot set up options by accessing the [Printer Properties]
dialog box from an application.

ﬂ Click [Start] on the taskbar, point to [Settings], and then click [Printers].
The [Printers] window appears.

& Note

O With Windows XP Professional, access the [Printers and Faxes] window
from [Start] on the taskbar.

O With Windows XP Home Edition, access the [Printers and Faxes] window by
clicking [Start] on the taskbar. Then click [Control Panel], [Printers and Other
Hardware] and then [Printers and Faxes].

ﬂ Click the icon of the machine you want to use.
E) On the [File] menu, click [Properties].
O Click the [Device Settings] tab.

B Use the [Installable Options] group to select the option, and then select the ap-
propriate setting for the option from the drop-down list box.

E Repeat step | for all options.
ﬂ After making all settings you want, click [OK].
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Windows NT 4.0 - Installing the PostScript 3 Printer Driver

Installing the printer driver

It is necessary to install a printer driver and a PPD file to print from Windows
NT 4.0. Follow these steps to install a printer driver and a PPD file.

? Limitation

O Installing a printer driver requires Full Control access permission. Members
of the Administrators, Server Operators, Print Operators, and Power Users
groups have Full Control permission by default. When you install a printer
driver, log on using an account that has Full Control permission.

ﬂlmportant
O We recommend that you upgrade the Windows NT 4.0 operating system to

Service Pack 4 or later before installing the printer driver. Contact your Win-
dows retailer for more information about the latest version available.

& Note

O When prompted for the Windows 95/98/Me alternate printer driver loca-
tion, select the following folder on the CD-ROM:

e \ DRIVERS \ PS \ WIN9X_ME\(Language)
ﬂ Close all applications that are currently running.

ﬂ Click [Start] on the taskbar, point to [Settings], and then click [Printers].
The [Printers] window appears.

E) Double-click the [Add Printer] icon.
[Add Printer Wizard] starts.

ﬂ After making sure that the [My Computer] option has been selected, click
[Next].

A dialog box for selecting the machine port appears.

B Select the check box of the port you want to use, and then click [Next].
A dialog box for selecting the manufacturer and model name appears.

[ ciick [Have Disk].
A dialog box for installing the driver from a disk appears.

ﬂ Insert the CD-ROM into the CD-ROM drive.

B Change the drive name in the list box to the name of the CD-ROM drive,
and then click [Browse].
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g Double-click [DRIVERS], [PS], [NT4]. Then double-click the folder of the ap-
propriate language for the operating system.

M ciick [open].

B click [ok.
A dialog box for selecting the machine model appears.

[ﬂ Click to select the name of the machine whose driver you want to install,
and then click [Next].

A dialog box for changing the machine name appears.
[B Change the name of the machine if you want, and then click [Next].

m If you want to share this machine over the network, select [Shared]. If not,
select [Not shared]. Press [Next] to continue.

& Note

O When selecting [Shared], if necessary enter the location of the machine and
a comment about the machine.

[B In the next dialog box, you will be asked to print a test page. Select [No], and
then click [Finish].
The installer copies the printer driver and a PPD file from the CD-ROM to the
computer's hard disk.

& Note
O Print a test page after completing installation and restarting Windows.

[E Restart Windows.

Setting up options

? Limitation

O Changing the setting of the machine requires Full Control access permission.
Members of the Administrators, Server Operators, Print Operators, and Pow-
er Users groups have Full Control permission by default. When you setup op-
tions, log on using an account that has Full Control permission. For details
about access authority, see Help for Windows.

ﬂlmportant
O If the machine is equipped with certain options (Sorter or Memory Unit), you
should set up the options with the printer driver.

@ Note

O When setting up options, you should access the [Printer Properties] dialog box
from Windows. You cannot set up options by accessing the [Printer Properties]
dialog box from an application.
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ﬂ Click [Start] on the taskbar, point to [Settings], and then click [Printers].
The [Printers] window appears.

g Click the icon of the machine you want to use.
B On the [File] menu, click [Properties].
O Click the [Device Settings] tab.

B In the [Installable Options] group, select the option you have installed on the
machine.

The current setting appears in the [Change Setting] box.

B Use the [Change Setting] list to select the appropriate setting for the selected
option.

ﬂ Repeat steps | - @ for all options.
8 After making all option settings, click [OK].

Using Adobe PageMaker

If you use the machine under Windows 95/98/Me, Windows 2000/ Windows
XP, Windows NT 4.0 with Adobe PageMaker, you need to copy the PPD file to
the PageMaker folder.

The PPD file is the file with extension “.ppd”. It is in the folder “DRIVERS \ PS
\ WIN9X_ME \(Language)” on the CD-ROM.

The [WIN9X_ME] folder, inside the [PS] folder is for the Windows 95/98/Me op-
erating system. Use the folder at this level that is appropriate for the operating
system you are using.

The third folder, “(Language)” may be substituted by an appropriate language
name.

Copy this file with extension “.ppd” to the PageMaker folder.

For PageMaker 6.0 default installation, the directory is “C:\PM6\RSRC\PPD4”,
and for PageMaker 6.5 and 7.0 default installation, the directory is
“C:\PM65\RSRC\USENGLISH\PPD4" or “C:\PAGEMAKER7.0\RSRC\USEN-
GLISH\ PPD4”. The “USENGLISH” may vary depending on your language selec-
tion.

/O Reference

For more information about the language name, see p.17 “Installing the Print-
er Driver and Software”.
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Mac OS - Installing the PostScript 3 Printer Driver

Installing the printer driver

It is necessary to install a printer driver and a PPD file to print from a Macintosh.

Follow these steps to install a printer driver and a PPD file on Macintosh run-
ning the 7.6.1 operating system or later.

5] Preparation

If the AdobePS installation starts under Mac OS X, the desktop automatically
changes to the Classic environment. If you want to set a printer with Mac OS
X, see= p.29 “Mac OS X- Installing the PostScript 3 Printer Driver”

? Limitation

O For use with a Macintosh, Power PC is required.

& Note

O Adobe PS DRIVER version 8.7.2 and version 8.6 are stored in attached CD-
ROM. Use version 8.6. If version 8.6 is not worked properly, use version 8.7.2.

ﬂ Insert the CD-ROM into the CD-ROM drive.

g Double-click the CD-ROM icon.

B Double-click the [PS DRIVER] folder.

ﬂ Double-click the folder of the language you use.

B Double-click the installer icon.
The PostScript 3 printer driver installer window appears.

B Follow the instructions on the screen.

d Double-click [Extensions] in [System Folder].

B Double-click [Printer Descriptions].

g Double-click the CD-ROM icon on the desktop.

[m Double-click the folder of the language you use in the [Printer Descriptions]
folder.

mDrag the appropriate PPD file into [Printer Descriptions] in [Extensions] in
[System Folder].

m Restart Macintosh.
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Setting up the PPD file

5] Preparation

Make sure that the machine is connected to an AppleTalk network before per-
forming the following procedure.

ﬂ On the [Apple] menu, select [Chooser].
B Click the [Adobe PS] icon.

B In the [Select a PostScript Printer] list, click the name of the machine you want
to use.

ﬂ Click [Create].

B Click the printer description file you want to use, and then click [Select].

The PPD file is set up, and the [Adobe PS] icon appears at the left of the ma-
chine name in the list. Next, follow the procedure below to make the option
settings, or close the [Chooser] dialog box.

Setting up options

ﬂ On the [Apple] menu, select [Chooser].
B Click the [Adobe PS] icon.

B In the [Select the PostScript Printer] list, click the name of the machine you
want to use, and then click [Setup].

ﬂ Click [Configure].
A list of options appears.

B Select the appropriate setting for the option you want to set up.

& Note

O If the option you want to set up is not displayed, the PPD file might not be
set up correctly. Check the name of the PPD file shown in the dialog box.

A click [ok1.
The list of options closes.

1 click [0k,
The [Chooser] dialog box appears.

8 Close the [Chooser] dialog box.
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Mac OS X- Installing the PostScript 3 Printer Driver

To print from Mac OS X, use the printer driver installed with Mac OS X. How-
ever, it is not possible to utilize all the features of the printer with the printer
driver alone. To fully utilize the printer’s functions, the PPD file must also be in-
stalled.

? Limitation

O For use with Mac OS X version 10.1 or later.
O For use with a Macintosh, Power PC is required.

Installing the PPD File

It is necessary to install a PPD file to print from a Macintosh.

5] Preparation

You need an administrator name and a password (phrase). For more informa-
tion, consult your administrator.

ﬂ Double-click the [Resources] folder to open it.

& Note
O The [Resources] folder is located in the following location.

Library/Printers/PPDs/Contents
g Double-click the CD-ROM icon.

B Double-click the [Printer Description] folder to open it, and then double-click
the [Mac OS X] folder.

ﬂ Double-click the folder of the language you use in the [Mac OS X] folder.

B Drag the appropriate PPD file into an each language folder in the [Re-
source] folder on the hard disk.

ﬂlmportant
O Drag the appropriate PPD file for the printer being used.

O Use the appropriate language folder in the [Resource] folder:[en.Iproj] folder
(English), [de.lproj] folder (German), [fr.Iproj] folder (French), [it.Iproj] folder
(Italian), [es.lproj] folder (Spanish), [nl.Iproj] folder (Dutch).

O When the language you use is not English, drag the PPD file into [en.lproj]
and the folder of each language in the [Resource] folder on the hard disk.

B The PPD file is installed. Next, select the printer.
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Setting up the PPD file

5] Preparation
Make sure that the machine is connected to an AppleTalk network before per-
forming the following procedure.

ﬂ Run Print Center.

g Click [Add Printer].
Select [AppleTalk] in the first pop-up menu.
If the zone has been set, select the zone in the second pop-up menu.

B Select the PPD file of the model you are using from the [Printer Model:] pop-
up menu, and then click [Add].

Setting up options

® Limitation
O You cannot make the printer option settings under Mac OS X. Do not make
settings for options that have not been installed.
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Installing the PCL 5e Printer Driver

This section describes basic instructions for installing the PCL 5e printer driver.
The actual procedure may vary depending on the operating system. Follow the
appropriate procedure below.

? Limitation

O The PCL 5e printer driver cannot be used in the machine that has a resolution
of 400 dpi.

ﬂlmportant

O When updating the printer driver by installing the latest version, you should
uninstall the former version . See “Uninstalling the Printer Driver and Software”
in the Printer Reference 2.

Windows 95/98/Me - Installing the PCL 5e Printer Driver

5] Preparation

The Windows 95/98 CD-ROM may be required during installation. Make
sure to have the CD-ROM ready before installation.

ﬂ Close all applications that are currently running.

ﬂ Click [Start] on the taskbar, point to [Settings], and then click [Printers].
The [Printers] window appears.

E) Double-click the [Add Printer] icon.
[Add Printer Wizard] starts.

ﬂ Click [Next].

B Check [Local printer] and click [Next].
A dialog box for selecting the manufacturer and model name appears.

[ ciick [Have Disk].
A dialog box for installing the printer driver from a disk appears.

ﬂ Insert the CD-ROM into the CD-ROM drive.
B Click [Browse].
g Use the [Drives] list box to select the CD-ROM drive.

[E In the [Folders] box, double-click [DRIVERS], [PCL5E], [WIN9X_ME]. Then dou-
ble-click the folder of the appropriate language for the operating system.
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B click [ok.

B crick (oK.
A dialog box for selecting the machine model appears.

[B Click to select the name of the machine whose driver you want to install,
and then click [Next].

[ﬂ In the [Available ports] box, click to select [Printer Port], and then click [Next].
A dialog box for changing the machine name appears.

[B Change the name of the machine if you want, and then click [Next].

[@ In the next dialog box you will be asked to print a test page. Select [No] and
then click [Finish].

& Note
O Print a test page after completing installation and restarting Windows.

m Restart Windows.

& Note

O As the PCL printer driver is Microsoft's mini driver, the items that can be
set are few compared to the PostScript 3 printer driver.

Windows 2000/Windows XP- Installing the PCL 5e Printer Driver

? Limitation

O Installing a printer driver requires Manage Printers permission. Members of
the Administrators and Power Users groups have Manage Printers permis-
sion by default. When you install a printer driver, log on using an account
that has Manage Printers permission.

& Note

O If you want to share the machine on Windows 2000/ Windows XP, use the
[Sharing] tab in the Printer Properties to specify the alternate printer driver.
For details, see the operating instructions for Windows 2000/ Windows XP.

O When prompted for the alternate printer driver location, select the following
folder on the CD-ROM:

¢ Windows 95/98/ME:\ DRIVERS \ PCL5E \ WIN9X_ME \(Language)

e Windows 2000, Windows XP:\ DRIVERS \ PCL5E \ WIN2000 \(Lan-
guage)

¢ Windows NT4.0:\ DRIVERS \ PCL5E \ NT4 \(Language)

O When PCL 5e driver of Windows 95/98/Me is shared on Windows 2000, fol-
low ARTICLE -ID:Q142667 of Microsoft Knowledge Base to install a printer
driver.
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ﬂ Close all applications that are currently running.

ﬂ Click [Start] on the taskbar, point to [Settings], and then click [Printers].
The [Printers] window appears.

& Note
O With Windows XP Professional, access the [Printers and Faxes] window
from [Start] on the taskbar.

O With Windows XP Home Edition, access the [Printers and Faxes] window by
clicking [Start] on the taskbar. Then click [Control Panel], [Printers and Other
Hardware] and then [Printers and Faxes].

B Double-click the [Add Printer] icon.
[Add Printer Wizard] starts.

& Note
3 With Windows XP, Click [Add a printer].

ﬂ Click[ Next].

B After making sure that the [Local Printer] option has been selected, click
[Next].

A dialog box for selecting the machine port appears.

E Select the port you want to use, and then click [Next].
A dialog box for selecting the manufacturer and model name appears.

 ciick [Have Disk].
A dialog box for installing the driver from a disk appears.

B Insert the CD-ROM into the CD-ROM drive.

g Change the drive name in the list box to the name of the CD-ROM drive,
and then click [Browse].

[E Double-click [DRIVERS], [PCL5E], and [WIN2000]. Then double-click the fold-
er of the appropriate language for the operating system.

ﬂ] Click [Open].

@ click [oK].
A dialog box for selecting the machine model appears.

[B Click to select the name of the machine whose driver you want to install,
and then click [Next].

A dialog box for changing the machine name appears.

m Change the name of the machine if you want, and then click [Next].
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[B If you want to share this machine over the network, select [Share as]. If not,
select [Do not share this printer]. Press [Next] to continue.

@ Note

O When selecting [Share as], if necessary enter the location of the machine
and a comment about the machine.

[E In the next dialog box you will be asked to print a test page. Select [No] and
then click [Next].

A confirmation dialog box appears.

& Note
O Print a test page after completing installation and restarting Windows.

m Make sure that the settings you have set are correct, and then click [Finish].

& Note
O If the [Digital Signature Not Found] dialog box appears, click [Yes] to continue
the installation.

O During installation in Windows XP, the [Hardware Installation] dialog box
may appear. In this case, click [Continue Anyway] to continue the installa-
tion.

m Restart Windows.

& Note
O As the PCL printer driver is Microsoft's mini driver, the items that can be
set are few compared to the PostScript 3 printer driver.



Installing the PCL 5e Printer Driver

Windows NT 4.0 - Installing the PCL 5e Printer Driver

5] Preparation

The Windows NT CD-ROM may be required during installation. Make sure
to have the CD-ROM ready before installation.

? Limitation

O Installing a printer driver requires Full Control access permission. Members
of the Administrators, Server Operators, Print Operators, and Power Users
groups have Full Control permission by default. When you install a printer
driver, log on using an account that has Full Control permission.

@ Note

O If you want to share the machine on Windows NT 4.0, use the [Sharing] tab in
the Printer Properties to specify the alternate printer driver. For details, see
the operating instructions for Windows NT 4.0.

O When prompted for the Windows 95/98/Me alternate printer driver loca-
tion, select the following folder on the CD-ROM:

e \ DRIVERS \ PCL5E \ WIN9X_ME \(Language)

O When PCL 5e driver of Windows 95/98/Me is shared on Windows NT4.0,
follow ARTICLE-ID:Q142667 of Microsoft Knowledge Base to install a printer
driver.

ﬂ Close all applications that are currently running.

g Click [Start] on the taskbar, point to [Settings], and then click [Printers].
The [Printers] window appears.

B Double-click the [Add Printer] icon.
[Add Printer Wizard] starts.

ﬂ After making sure that the [My Computer] option has been selected, click
[Next].

A dialog box for selecting the machine port appears.

B Select the check box of the port you want to use, and then click [Next].
A dialog box for selecting the manufacturer and model name appears.

E Click [Have Disk].
A dialog box for installing the driver from a disk appears.

ﬂ Insert the CD-ROM into the CD-ROM drive.

8 Change the drive name in the list box to the name of the CD-ROM drive,
and then click [Browse].
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ﬂ Double-click [DRIVERS], [PCL5E], [NT4]. Then double-click the folder of the
appropriate language for the operating system.

@ crick [openi.
@ crick [ok1.
A dialog box for selecting the machine model appears.

[ﬂ Click to select the name of the machine whose driver you want to install,
and then click [Next].

A dialog box for changing the machine name appears.
[B Change the name of the machine if you want, and then click [Next].

m If you want to share this machine over the network, select [Shared]. If not,
select [Not shared]. Press [Next] to continue.

& Note
O When selecting [Shared], if necessary enter the location of the machine and
a comment about the machine.

[B In the next dialog box you will be asked to print a test page. Select [No] and
then click [Finish].

& Note
O Print a test page after completing installation and restarting Windows.

[E Restart Windows.

& Note
O As the PCL printer driver is Microsoft's mini driver, the items that can be
set are few compared to the PostScript 3 printer driver.



e
3. Basic Printing

Printing Data from Your Computer on the
Printer

For general printing, printing done with the Auto On Line function is used as an
example for explanation purposes.

@ Note

O Auto On Line is a function that starts printing automatically once printing
starts from a computer. Pressing the [Auto On Line] key on the control panel
lights its indicator and enables the function.

A Reference
See the Operating Instructions for information about operation details.

Windows-Printing

Create some data beforehand to be printed from your computer.
Here Windows 98 is used as an example for explanation purposes.

ﬂ Make sure that the machine is turned on, and press the [Auto On Line] key
if the Auto On Line indicator is not lit.

& Note
O When the machine is in Auto On Line status, the indicator will be lit.

g Display the data to be printed on the computer, and then click [Print] from
the [File] menu.

The [Print] dialog box appears.
B Select the machine you want to use in the [Printer] box.

ﬂ Click [Properties] to display the [Properties] dialog box, and then click the [De-
vice Options] tab.

& Note
O When using Windows 2000, click [Advanced] on the [Paper/Quality] tab or the
[Layout] tab.

O When using Windows XP, click [Preference] and then click [Advanced] on
the [Paper/Quality] tab or the [Layout] tab.

O When using Windows NT 4.0, click the [Advanced] tab.
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Printing without proof printing

@ Click “Auto-Print after Master Making” in [Printer features], and then se-
lect “On” in the [Change Setting for] box.

@ Click [Apply], and then [OK].

© Enter the number of prints required, and select the print range.

O Click [OK] to start printing.
When the machine receives data from the computer, it enters the online
status and Data In indicator flashes.

& Note

O To stop the machine before Master Making, press [Job Reset]. However,
for a page where Master Making has begun, Master Making cannot be
cancelled even if [Job Reset] is pressed.

O To stop the machine during printing, press the [Clear/Stop] key. If there is in-
coming data from the computer to the machine, press [Job Reset] to clear it.

O As this machine performs Proof Printing, one more set than the set
number will be printed. For example, if the set number was two, three
print sets will be printed and delivered.

Printing after proof printing

@ Click “Auto-Print after Master Making” in [Printer features], and then se-
lect “Off” in the [Change Setting for] box.

@ Click [Apply], and then [OK].
© Enter the number of prints required, and select the print range.
O Click [OK] to start printing.

When the machine receives data from the computer, it enters the online
status and Data In indicator flashes. The Proof Printing page is output.

& Note
O To stop the machine before Master Making, press [Job Reset].

O If the [Proof] key is pressed, Proof Printing can be performed again.
@ Check the result of the proof print.
@ Press the [Print] key.

Printing starts.

& Note
O To stop the machine during printing, press the [Clear/Stop] key. If there is in-
coming data from the computer to the machine, press [Job Reset] to clear it.

O When there is no data to be printed afterwards, “Ready for Master Mak-
ing/Printing” is displayed on the display panel.



Printing Data from Your Computer on the Printer

Macintosh-Printing

Create some data beforehand to be printed from your Macintosh.

ﬂ Make sure that the machine is turned on, and press the [Auto On Line] key
if the Auto On Line indicator is not lit.

& Note
O When the machine is in Auto On Line status, the indicator will be lit.

g Display the data to be printed on the Macintosh, and then click [Print] from
the [File] menu.

The [Print] dialog box is appears.
B Select the machine you want to use in the [Printer] box.
ﬂ Click [Printer Specific Options] in the drop down menu.

& Note
O Under Mac OS X, this is called [Printer Features].

Printing without proof printing

@ Select “On” in “Auto-Print after Master Making”.
@ Enter the number of prints required, and select the print range.
© Click [Print] to start printing.

When the machine receives data from the computer, it enters the online
status and Data In indicator flashes.

& Note

O To stop the machine before Master Making, press [Job Reset]. However,
for a page where Master Making has begun, Master Making cannot be
cancelled even if [Job Reset] is pressed.

3 To stop the machine during printing, press the [Clear/Stop] key. If there
is incoming data from the computer to the machine, press [Job Reset] to
clear it.

O As this machine performs Proof Printing, one more set than the set
number will be printed. For example, if the set number was two, three
print sets will be printed and delivered.
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Printing after proof printing

@ Select “Off” in “Auto-Print after Master Making”.
@ Enter the number of prints required, and select the print range.
© Click [Print] to start printing.

When the machine receives data from the computer, it enters the online
status and Data In indicator flashes. The Proof Printing page is output.

& Note

O To stop the machine before Master Making, press [Job Reset].

O If the [Proof] key is pressed, Proof Printing can be performed again.
O Check the result of the proof print.
@ Press the [Print] key.

Printing starts.

& Note

3 To stop the machine during printing, press the [Clear/Stop] key. If there
is incoming data from the computer to the machine, press [Job Reset] to
clear it.

O When there is no data to be printed afterwards, “Ready for Master Mak-
ing/Printing” is displayed on the display panel.

Changing the Number of Prints During Printing

You can change the number of prints on the machine while it is printing.

ﬂlmportant

O Change the number of prints for individual pages. For example, when the
machine is printing the second page and you change the number of prints
from one to two, the second page will be printed twice. The first page and
pages from the third page on will only be printed once.

ﬂ Press the [Clear/Stop] key when printing a page for which you want to
change the number of prints.
When printing is interrupted, “Processing” will be displayed.

& Note
O When canceling printing from the following pages, press [Job Reset].

g Enter the number of prints using the number keys on the machine.

B Press the [Print] key.

Printing restarts. When the specified number has been printed, Master Mak-
ing of the next page begins.
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E
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Mac OS
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Windows 2000, Install, 32
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Windows NT 4.0, Install, 35
Windows XP, Install, 32
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PPD files, 2

Prev., 7

Printer driver, 2

Printing, 37, 39
Macintosh, 39
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Print key, 5

Proof key, 5
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Select, 7

SmartNetMonitor for Admin, 4
SmartNetMonitor for Client, 4
Start key, 5

Subnet mask, 11

U

User Tools key, 5
\')

Valid protocol, 11

w

Windows 2000
PCL b5e, Install, 32
PostScript 3, Install, 21
Windows 95/98/Me
PCL 5e, Install, 31
PostScript 3, Install, 19
Windows NT 4.0
PCL 5e, Install, 35
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PCL 5e, Install, 32
PostScript 3, Install, 21
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Declaration of Conformity

“The Product complies with the requirements of the EMC Directive 89/336/EEC and the Low Voltage
Directive 73/23/EEC.”

Caution:
Network interface cables with ferrite core must be used for RF interference suppression.

Copyright © 2002
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